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2016 Computex
See http://bit.ly/1rvQLZQ for an overview of this
Taipei trade show, including a 10-core CPU from
Intel (at $1,723!), 7th generation APUs from AMD,
new GPUs from AMD and Nvidia, new
motherboards, a 512 GB SSD from Samsung the
size of a postage stamp, etc.

How Intel Makes a Chip
Bloomberg Businessweek (June 13-June 26, 2016,
pp. 94-100) has published an excellent article on
how Intel manufactures computer chips. Here
are a few highlights:
• It costs at least $8.5 billion to create a factory
to build chips.
• Starting with a 12-inch silicon disk, each disk
yields 122 Xeon E5 CPUs selling for $4,115 each.
These are CPUs used in high end servers, not
home computers.
• Chips are created through 2,000 steps of
photolithography (a form of printing) and the
deposition of ultra-thin layers of materials,
some the thickness of a molecule.
• Each Xeon E5 has up to 7.2 billion transistors.
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• By 2026 such CPUs are expected to have more
transistors than the human brain has neurons
(~100 billion).
• Intel manufacturing works on a 14 nm scale. In
comparison a human red blood cell is 7,000 nm
across and a typical virus is 100 nm in size.

Look Into My Eyes…
Researchers at Brown University
have developed eye-tracking
technology that can be added to
any Web site. To quote from
http://bit.ly/1tDn2jL
Overall, it could help website developers prioritize
popular or eye-catching content, optimize a page’s
usability, or place and price advertising space.
Further ahead, potential applications could include
eye-controlled gaming or broader accessibility.

Mac Internet Recovery
Newer Mac computers have the ability to bootup from the Internet, should your hard drive be
completely dead. See http://bit.ly/1UiqiMN for
detailed information and http://bit.ly/1tvBCcr
for a useful video on this topic. If the operating
system is corrupted and/or the the disk drive is
repairable, recovery can often be achieved by
using Disk Utility and/or reinstalling the OS from
(Continued on page 2)
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the recovery partition (see http://apple.co/
1tDmOZP). This is a topic that may warrant being
prepared for—think fire drill. Of course, you can
always drop off your computer at an Apple store
for repair.

Symptoms ofMalware Infection
How do you know if you’ve been infected with
some kind of malware? It’s an increasing
problem. Here’s what you might experience:
• Computer slows down.
• Unwanted pop-ups appear.
• Computer crashes.
• Suspicious hard drive activity.
• Running out of hard drive space.
• Unusually high network activity.
• New browser homepage and/or toolbars.
• Unusual messages or programs that start
automatically.
• Disabled security software.
• Friends tell you they are getting strange
messages from you.
• A program holds your computer for ransom
(you won’t have to look for this).
For details see http://bit.ly/1rvQIgP,
http://bit.ly/1V8Bw0t and
http://bit.ly/1Y2PdoR.

Audits ofOpen Source Software
How safe and secure is open source software? In
principle, anyone can make changes to it and
potentially introduce flaws that the bad guys
could exploit. Mozilla has set up an initial
$500,000 fund called “Secure Open Source” to
provide security audits of open source code.
Mozilla is hoping that companies and
governments that use open source software will
join in the effort and provide additional funding.
See http://bit.ly/1WWSXaA.

UPS Maintenance
We generally ignore our UPS units
(uninterruptible power supply) until they don’t
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work. The power goes off and your computer,
and other attached equipment, goes down.
Generally, our UPS units are just left in some outof-the-way location (under a desk, in a closet,
etc.) and ignored; that’s what I do. It would be
prudent to visually check UPS devices every six
months or so to see if the batteries are being
charged and everything you think is plugged in is
indeed properly plugged in. Sealed lead batteries
deteriorate over time with most manufacturers
recommending they be replaced after three years
or so. Some inexpensive UPS devices don’t have
replaceable batteries and the whole unit needs to
be replaced. Recently we had a power failure and
my Mac computer went down at the same time.
What? Why didn’t the UPS do its job? Checking
the panel of my APS Model XS 1000 showed dead
batteries. So either the batteries were indeed
dead or the UPS wasn’t charging them. Replacing
the 6-year old batteries solved the problem. By
the way, replacing the two batteries in this
particular UPS is a bit challenging. Yes… do as I
say (write) and not as I do!

Updates to Office for Mac
Many Apple computer users also use Microsoft
Office rather than the office automation tools
that come with Mac computers (e.g. Pages,
Numbers, Keynote, Mail, Calendar, etc.).
Microsoft has provided information at
http://bit.ly/24ZlBHz that provides information
on updates.

Upcoming Meetings
Refer to the PATACS Event Calendar on the back
cover or http://patacs.org/mtgdetpat.html for
meeting time and location.

September 7, 2016 (Tysons Corner)
Presentation: Microsoft Band

The Microsoft Store in Tysons Corner Center
(http://www.microsoft.com/enus/store/locations/va/tysons-corner/tysonscorner-center/store-10) will host a meeting
about the Microsoft Band wearable device.

www.patacs.org
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Pam oversees curriculum development and manages a
wonderful team of tech coaches who share her love of
helping older adults get the most out of their technology.

(Continued from page 2)

September 17, 2016 (Fairfax)
Welcome Fall Celebration

September 28, 2016 (Arlington)

Join us in the Social Annex for a
party complete with food and
refreshments! “Learn in 30”
(formerly “Learn 30”) tutorial
sessions will resume in October.

Technology & PC Help Desk

Presentation: Social Media for the NonTweeter by Pam Holland, President,
TechMoxie

Extended Question and Answer
session; discuss topics of
interest, share knowledge and
get help with technology issues.

October 15, 2016 (Fairfax)

Notice of Annual Meeting and Officer Election

Even if you have not yet ventured into the world
of Social Media, there is much to learn about how
it is shaping communications in personal
relationships, business, government and, of
course, politics. Join us for a tour of and critical
look at the most popular social media sites
including Twitter, Facebook, and Instagram. We
will explore the benefits – and risks – in using
these sites for breaking news, promoting the
arts, research, social connection and
communication. Pam will explain many of the
new terms that are cropping up along with the
new technologies such as hashtag, tweet, and
follow. Bring your questions!

Per Article V, Section 1 of the PATACS Bylaws
(http://www.patacs.org/orgdocs/bylaws_patacs_2012_v7_120502.pdf), notice is
hereby given that the Annual Meeting of the
organization will be held at 1 PM ET on October
15, 2016 at the Osher Lifelong Learning Institute
Tallwood facility, 4210 Roberts Road, Fairfax,
Virginia in room TA-1.

After more than 20 years as a business lawyer specializing
in compliance and risk management, Pam founded
TechMoxie out of a love of technology and a passion for
simplifying the complex. Her work as an attorney included
representing clients on technology initiatives and process
improvements that require aligning business needs and
legal risk. Pam founded TechMoxie to help businesses and
individuals keep up with every day technology. TechMoxie
develops and delivers classes and provides individual
consulting and coaching on business applications, personal
technology and best practices for online privacy and
security. Pam’s teaches seniors and professional caregivers
how to recognize and respond to phishing, scams,
password best practices as well as steps to take assure
adequate back up and safe storage of sensitive non-public
information.

The notification and voting process are described
under Article VII.

Pam obtained a B.A. from the University of Massachusetts
in 1984 and a J.D. from the Columbus School of Law at The
Catholic University of America in 1988. Pam recently
served on the board of directors of A Wider Circle in Silver
Spring, Maryland and is active in a number of community
organizations including Rotary International, the Bethesda
Chamber of Commerce, and the Montgomery County Vital
Living Network.

Per Article VI, Section 1, members in good
standing shall elect PATACS Officers for a two
year term at the Annual Meeting. The Officer
positions are President, First Vice President,
Second Vice President, Treasurer, and Secretary.

Watch for the election ballot with the
slate of candidates in your e-mail, or
vote in person at the meeting. Write-in
candidates are accepted.
Learn in 30: Amazon Echo by Lorrin Garson
Presentation: Wearable Computing by Vivian
Motti, George Mason University

November 19, 2016 (Fairfax)

Learn in 30: HD Sentinel by Ray Parker
Presentation: Voice Command of
iDevices/Android by Cherie Lejeune

www.patacs.org
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IfYou Missed It
by Geof Goodrum

Director, Potomac Area Technology and Computer Society
Director1(at)patacs.org

If you can’t make a meeting in person, remember
that members can participate in meetings
remotely (and at no additional charge beyond
your Internet connection service) via Zoom
teleconferencing. See http://zoom.us/, for
Apple® macOS™ and iOS, GNU/Linux®, Google
Android™ and Microsoft® Windows® clients.
Details are provided in e-mailed meeting
announcements.
Remember: you must be physically present at the
end of the meeting to be eligible for door prizes.

July 16, 2016 (Fairfax)
Paul Howard announced that the August 20th
Fairfax meeting will be online-only via
participation in the APCUG Virtual Technology
Conference (VTC, http://apcug2.org/apcug-2016summer-virtual-technology-conference-vtc21/).
As previously announced, parking lot
construction is scheduled to close the OLLI
meeting site in August, and we found too much
red tape and potential costs to meet at the
Fairfax County Government Center. Paul
summarized topics in the two simultaneous VTC
meeting tracks, including Facebook: Friend or
Foe, how technology changed how we listen to
music, and upgrading your laptop. The VTC uses
the same Zoom teleconferencing application that
PATACS uses. Gabe Goldberg recommended
Zoom as an easy to use app.
Paul noted that it costs $200 per year to provide
the snacks, sodas and coffee during the meeting
break in the Social Annex, and we need more
contributions to the OLLI tip jar there to cover
this expense as well as a party once
per year.

Q&A Session
Q: I want to upgrade from Windows 7 to Windows
10. Where do I find the upgrade?
A: If you have been applying Windows 7 updates
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and haven’t disabled the upgrade, click on the
“tilted” Windows icon in the notification area to
install Windows 10.
Q: Is Windows Defender (https://en.wikipedia
.org/wiki/Windows_Defender) as good as other
antivirus programs?
A: Which one is best is debatable. Everybody has
a favorite, but you can find a problem with any of
them. Paul Howard uses Symantec/Norton
products, but a Google researcher found a major
vulnerability recently
(http://www.theregister.co.uk/2016/06/29/sym
antec_enterprise_endpoint_project_zero/).
What’s best today may not be best tomorrow.
You may not get support with the free versions.
Stan Schretter noted that members of OLLI can
get licensed antivirus software at no charge
through George Mason University
(https://itservices.gmu.edu/downloads/index.cf
m). Geof Goodrum said that Internet Service
Providers sometimes provide licensed security
software to customers (e.g.,
https://constantguard.xfinity.com/). [Ed. One
site that tests and rates antivirus products is
https://www.av-test.org/en/.]
Comment: One attendee uses and recommends
1Password software (https://1password.com/) to
store all of his passwords. He said that it works
well and has good support. Paul Howard prefers
RoboForm (http://www.roboform.com/) and
also suggested LastPass (https://lastpass.com/),
both from companies based in Fairfax, Virginia.
Q: Is there any place to forward scam e-mails?
A: Complaints about scams, ripoffs, identify theft,
etc. can be filed with the US Federal Trade
Commission at
https://www.ftccomplaintassistant.gov/. You
can also forward (do not cut & paste) original
unsolicited e-mail to spam@uce.gov. Scams
related to Federal tax returns should be reported
to the US Department of the Treasury,
https://www.treasury.gov/services/reportfwa/Pages/ReportFWA.aspx.
(Continued on page 5)

www.patacs.org

September 201 6

PATACS Posts

(Continued from page 4)

Comment: An audience member received an email notice from the Virginia Department of
Environmental Quality that her car did not need
an emissions inspection, but included a link to
pay the fee. [Ed. Always be suspicious of links in
e-mail. See http://www.pcworld.com/article
/248963/how_to_tell_if_a_link_is_safe_without_
clicking_on_it.html.] This notice appears to be
tied to Virginia’s On-Road Emissions Program
(http://www.deq.virginia.gov/Programs/AirChe
ckVirginia/ForMotoristsVehicleOwners/OnRoad
EmissionsProgramFAQ.aspx). During the
discussion, Geof Goodrum noted that his 2002
Honda Insight hybrid is exempt from the
biennial Virginia emissions inspection
(http://www.deq.virginia.gov/Programs/AirChe
ckVirginia/ForMotoristsVehicleOwners/Vehicle
EmissionsInspectionFAQ.aspx#hybrid).
Comment: Gabe Goldberg offered that the Fairfax
County Police Department website
(http://www.fairfaxcounty.gov/police/) and
Twitter account (https://twitter.com/
fairfaxpolice) have a lot of useful information,
including reports on helicopter activity.

Learn in 30: Android Apps on a
PC? by Stan Schretter
Stan Schretter stated up front that he
is an Apple person and doesn’t use
Google’s Android operating system (OS) very
much. He noted that Google funds two thousand
Android developers, has seven to eight times as
many apps than Apple, but Apple makes more
money from apps.
Jide Co, Ltd (http://www.jide.com/) developed a
version of the Android OS called Remix OS for
various devices. Stan has a tablet running Remix
OS that he prefers over Google’s Chrome (web
browser-based) OS for taking notes in class. The
tablet looks much like the original Microsoft
Surface tablet, but is rather heavy. The cost is
about $200 with keyboard. There are icons on the
bottom of screen and more can be added to the
desktop. It also has a file browser, supports cut &
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paste, and items can be moved with the
touchscreen or with a mouse. The Remix OS
supports automatic updates, is easy to use, and
supports apps multitasking—Stan mentioned
running three different videos simultaneously.
Jide also sells the Mini (http://www.jide.com/
mini), a little box running Remix OS that can
attach to a HDMI display and costs about the
price of a Raspberry Pi [Ed. The 2GB RAM version
sells for $50-$70]. Stan suggested adding a
Bluetooth keyboard and mouse.
Jide released a free download version of the
Remix OS for x86-based PCs that can be run from
a USB thumbdrive without installing to a hard
drive. When asked why would someone would do
that, Stan replied that Remix OS would be useful
on netbooks and for an inexpensive PC. Paul
Howard commented that it would be worth
running Remix OS on an old Windows XP
netbook, which otherwise should not be
connected to the Internet. There is also a Remix
OS for XDA supporting various mobile devices
and Single Board Computers.
Comment: It seems that there is more malware
for Android. Stan replied that the Android OS
was not designed for malware prevention and he
does not recommend using it for sensitive
applications (banking, financial, etc.). [Ed. That
characterization is a bit harsh; Apple iOS has had
significant vulnerabilities while Android has
security features and anti-malware apps, too.
Regardless of platform, be careful what apps you
run (check history and user ratings) and the
permissions granted to the app, only use official
app sources, and use devices that receive regular
security updates.]
Q: Is Remix OS an alternative for a kid’s PC?
A: Remix OS is good for playing around with, and
can help kids who don’t have a smartphone
become familiar with the technology.
Stan recommended that PC users should keep an
open mind and give other operating systems a
try.
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Presentation: Digital Storage by Lorrin
Garson
Lorrin Garson gave another thorough, wellresearched presentation based upon his forty
years of experience with information technology.
All of us use disk drives of one type or another
regardless of the computer type. Lorrin provided
an overview of devices that are used for storage
with a focus on consumer products, with a
summary of pros and cons, prices, and a glimpse
at future storage technology.
How much storage do you need? What kind?
Lorrin started with an example from his
computer, which has a 500 Gigabyte (GB; one GB
is roughly equivalent to one billion text
characters) Solid State Drive (SSD), of
which 100 GB is used by his personal
files. Lorrin also uses external 2
Terabyte (TB; one TB is roughly
equivalent to one trillion text
characters) USB 3.0 drives for backup
and storage, with 570 GB of photos on
external storage.
Optical media include Compact Discs (CDs) and
Digital Versatile Discs (DVDs), which are not used
as much anymore. [Ed. the convention is to refer
to spinning magnetic media as “disk” and optical
media as “disc”.]
Magnetic storage media includes Hard Disk
Drives (HDDs), tape (mostly business use), and
floppy disks. Lorrin noted that floppy disk drives
are available with Universal Serial Bus (USB)
connectors if you need to access data on floppy
disks. IBM introduced digital tape in 1952 with a
storage capacity of 2 MB per tape. Tape storage is
still widely used by large businesses because it is
inexpensive for storing large volumes of data,
but data recovery is slow.
Lorrin noted that IBM produced the first hard
disk drive in 1956, which stored 3.75 Megabytes
(MB), and discussed factors affecting price and
performance with sample prices from February
(when he first prepared the presentation). The
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“sweet spot” was 2-3 TB capacity drives for $95100. Lorrin also produced an amusing and
enlightening comparison of the change in price
per TB since 1979 and how low car prices would
be if they paralleled the drop in disk drive prices
per unit storage. Lorrin also showed a life
expectancy chart and failure rates by
manufacturer for HDDs that showed half survive
for six years.
Solid State (all electronic) devices include SSDs,
USB thumb drives, and memory cards typically
used in mobile devices such as cameras, phones,
and music players. Thumb drives use USB
connectors; but come in many shapes (Lorrin
showed examples molded to look like an actual
thumb and another built into a pocket knife).
There are thumb-drives that feature builtin encryption to secure data in case of
loss or theft, but these are much more
expensive and there are other ways
(e.g., encrypted filesystems, zip file
utilities) to encrypt files on commodity
drives. Lorrin found the thumb drive
“sweet” spot (i.e., (lowest cost per unit storage)
was at 256 GB capacity. Memory cards come in
many different varieties, but are dominated by
Secure Digital High-Capacity (SDHC) and Secure
Digital eXtended-Capacity (SDXC). The sweet
spot is 32 GB for SDHC and 128 GB for SDXC.
SSDs are very fast, quiet, low power, and have no
moving parts, but they cost about seven times
the cost of an equivalent size HDD. SSDs do wear
out because the solid state memory has a finite
number of writes. A built-in process called wear
leveling distribute the writes to maximize life of
the device. There is also some controversy over
whether data deterioration will occur if the drive
is left unplugged. However, SSDs are likely to last
as long as the computer. Lorrin presented a table
comparing SSDs and HDDs, and found the “sweet
spot” was 240-512 GB SSDs. There was a question
about the shelf life of a HDD left in the box. Gabe
Goldberg recalled advice from Keystone
Computer that HDD lubricant wears away and
the drive should be replaced after five years.

www.patacs.org
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Hybrid drives (SSHDs) combine HDDs with solid
state memory to improve performance for
frequently accessed files while avoiding the high
cost of a pure SSD.
Common hardware interfaces for disk drives
include the older Parallel AT Attachment (PATA)
and newer Serial AT Attachment (SATA). The
SATA interface transfers data at up to 6 Gigabits
(Gb; roughly one-tenth of a GB) per second. Other
interfaces include external USB, external SATA
(eSATA), Gigabit Ethernet, FireWire, and
Thunderbolt. As the USB specification evolved,
the maximum transfer rate increased from 12
Megabits per second (USB 1.0) to 480 Megabits
per second (USB 2.0) and 4.8 Gigabits per second
(USB 3.0), and the new USB-C specification
supports up to 10 Gigabits per second. The USB
physical connectors also changed. eSATA is used
for some external hard drives (Paul Howard
mentioned that Verizon specifies eSATA drives
to expand capacity of their FiOS digital video
recorders). The Firewire interface was once
popular but is obsolete now. Thunderbolt is used
mostly on Apple hardware used for graphics
design applications. Of these, USB-C is likely to
dominate. Network Attached Storage (NAS) is
available with Ethernet (wired) and wireless
connections. Lorrin noted some things to
consider when buying a NAS storage device, such
as providing more than one drive bay to allow for
a backup drive. Lorrin also provided a table of
models. There are Wireless Hard Disk Drives from
16 GB to 4 TB capacity, which are a type of NAS
that connect via the WiFi 802.11b/g/n/ac
protocols. NAS drives also replaced Microsoft’s
Windows Home Server, which never caught on in
the consumer market despite having more
features.
Lorrin discussed Redundant Array of
Independent Disks (RAID) that allows multiple
disks to be merged and provided a table of the
different modes available to provide better
performance, reliability or flexibility than a
single disk. RAID 1 (mirroring) is the most
common mode for home use, which writes the
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same data to two disks simultaneously so there is
a backup copy if one drive suddenly fails. [Ed.
Note that file deletions also occur on both disks
simultaneously, so you still need backup
software.]
Lorrin noted some future storage technologies.
New SSDs will have capacities of 10 TB, use 3D
NAND memory chips, and have greater durability
[Ed. Technology moves quickly. How about a 100
TB SSD? http://www.theregister.co.uk/2016/
08/10/toshiba_100tb_qlc_ssd/]. These will
eventually show up for home use. NAND
(negative “and” logic) chips from Micron are
1,000 times faster than current chips, but
interface standards must keep up to prevent a
bottleneck. Deoxyribonucleic acid (DNA) can be
used for data storage, is very stable, and has a
storage life for a million years, which gives it
potential to store archival data offline. Lorrin
provided a description of how DNA nucleotides
bond, and said that 700 TB of data could be stored
in one gram of DNA. Although DNA is not cost
effective currently, this will change. There is also
holographic storage in quartz, which can store
360 TB in the space of a CD with life expectancy
of 13.8 billion years.
Below are some of the questions from the
audience.
Q: What storage media is CD/DVD migrating to?
A: Online streaming is replacing CDs and DVDs.
Q: Are optical drives being replaced?
A: Apple no longer includes an optical drive in
their computers. Software is delivered via
download. Optical media no longer has enough
storage capacity to be used for backup.
Q: Are “portable” drives more robust than
external drives?
A: Not sure. [Ed. According to About.com
(http://peripherals.about.com/od/removablesto
rage/a/3-Tips-For-Buying-A-Portable-OrExternal-Hard-Drive.htm), an external drive has
a separate power source, wheras a portable drive
is powered by the computer it is attached to.]
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Q: How long do CDs and DVDs last?
A: High (or archival) quality media lasts up to 100
years, but cheap ones do not last as long.
Comments: Gabe Goldberg noted that a
presentation on hard drive hygiene is scheduled
for the November meeting in Fairfax. Geof
Goodrum said that SSDs can fail with little
warning, while HDDs may give warning signs
before failing [Ed. I was oversimplifying the SSD
report at https://techreport.com/review/
27909/the-ssd-endurance-experiment-theyreall-dead; SSDs and HDDs alike may or may not
give warnings before failing]. Regardless, always
keep a backup of your important data.
Lorrin’s presentation is posted on the PATACS
Recent Meetings page (http://patacs.org/
recmtgspat.html).

Open Source Software ofthe Month
by Geof Goodrum

Potomac Area Technology and Computer Society
linux(at)patacs.org

crosti/Stitch Designer – v1.13.2. https://sites.
google.com/site/crostiapp/. Free GNU General
Public License source code and executables for
Microsoft® Windows®, Apple® macOS™, Google
Android and GNU/Linux® by Sergey Levin. This
tool allows you to make your own unique cross
stitch scheme from a custom image. You can
resize and rotate the image, reduce the number
of colors, change image palette, make cross stitch
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scheme, preview it, save and print. Cross stitch
scheme edits include changing colors and icons,
adding new color, color fill, scheme pixel draw,
lines and half-stitches. Features include:
• Convert custom image to cross stitch scheme
• Edit cross stitch scheme
• Save and print the scheme that you created
• Input pictures: BMP, GIF, ICO, JPEG, JPG, MNG,
PBM, PGM, PNG, PPM, SVG, TIF, TIFF, XBM,
XPM
• Output cross stitch scheme: BMP, ICO, JPEG,
JPG, PNG, PPM, TIF, TIFF, XBM, XPM, PDF, CST
(crosti scheme text file)
jGnash – v2.24.0. https://sourceforge.net/
projects/jgnash/. Free GNU General Public
License source code and executables for
Microsoft® Windows®, Apple® macOS™ and
GNU/Linux® by Craig Cavanaugh. jGnash is a
cross platform personal finance application
written in Java. Features include:
• Double Entry Accounting with reconciliation
tools
• Budgeting with multiple scenario options and
export to spreadsheet capability
• Investment Accounts and automatic import of
Stocks, Bond, and Funds price history
• Nestable accounts with automatic rollup of
totals and intelligent handling of mixed
currencies
• OFX, QFX, mt940, and QIF import capabilities
• Reminders and automatic transaction entry
and notifications
• Intelligent handling of multiple currencies and
exchange rates with automatic online
exchange rate updates
• Printable reports with PDF and spreadsheet
export capability
• XML and relational database file formats
Kernel Source – v4.7. http://www.kernel.org/.
Free GNU General Public License source code for
all platforms by the Linux community.
(Continued on page 9)
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Above: PDFsam Merge menu for PDF files
(Continued from page 8)

PDFsam – v3.1.0.
https://sourceforge.net/projects/pdfsam/. Free
Affero GNU Public License source code and
executables for Microsoft® Windows®, Apple®
macOS™ and GNU/Linux® by Andrea Vacondio.
PDF Split and Merge (PDFsam) is an easy-to-use
desktop tool with graphical, command line and
web interfaces. Features include:
• Merge PDF files together
• Split PDF files specifying the page number
• Split PDF files specifying the level of
bookmarks
• Split a PDF in files of the given size
• Rotate PDF files
• Mix two PDF files taking pages alternately
• Extract pages from PDF files

SuperTuxKart – v0.9.2. https://supertuxkart
.net/Main_Page. Free GNU General Public License
source code and executable for Microsoft®
Windows®, Apple® macOS™ and GNU/Linux® by
Joerg Henrichs, Marianne Gagnon, Jean-Manuel
Clemençon and the SuperTuxKart Team.
SuperTuxKart is a 3D open-source arcade racer
with a variety characters, tracks, and modes to
play, focusing on fun and ease of play. Features
include:
• Race with Tux and friends
• Explore several tracks
• Play against AI or in split-screen mode against
your friends
• Play in various modes, including Time Trial,
Grand Prix and 3 Strikes Battle

www.patacs.org
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Windows 10 Tip:
Disable a Touchpad
by Leti Labell

Member, Potomac Area Technology
and Computer Society

You can disable your laptop’s mouse touchpad
whenever you have an external mouse connected
to your computer. Select “Settings” under the
Start Menu, then select “Devices (Bluetooth,
printers, mouse)”. Click on “Mouse & touchpad.”
Scroll down, and you will see “Leave touchpad on
when a mouse is connected.” Click to turn this
option OFF.

Enliven Documents with Themes
by Nancy DeMarte

1st Vice President, Sarasota Technology User Group, FL
October 2015 issue, Sarasota Technology Monitor
www.thestug.org
ndemarte (at) Verizon.net

If you often find yourself creating documents in
Word or spreadsheets in Excel, you probably use
the same font and layouts most of the time. You
would be surprised how lively and stylish these
files could be if you applied a theme to them.
Themes in Word and Excel are Style sets that
coordinate the color scheme, fonts, line and
paragraph spacing, and effects. The Themes
gallery is located on the Design tab in Word and
the Page Layout tab in Excel. I will use Word 2013
as an example of how you can apply and
customize themes in your documents.

Choose and Apply a Theme
The default
theme in Word
and other Office
programs is
appropriately
named “Office,”
but you can
apply a different
theme to a
document either
during its
creation or after.
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For example, I opened a blank document, clicked
the Design tab, then Themes (left side of the
ribbon), to open the Themes gallery. I chose the
“Ion” theme, although I could have browsed for
more online. A group of Styles that coordinate
with this theme appeared in the ribbon. I chose a
colorful one called “Lines (Simple)” and began to
create my document.
First, I typed the title and highlighted it to
display the Font toolbox just below it. I clicked
Styles (bottom right) and selected the Title style,
which changed my title to a maroon color and
40-point text. The title seemed too large, so I
reduced the font size to 24 points. All these font
changes can also be made on the Home tab – Font
group.
Next, I typed an introduction and my first
heading, highlighted it, chose Styles from the
font toolbox again, and picked Heading 1. It also
was a maroon color, 18 points, and included a
line below it. I changed the size to 14 points to be
consistent with the new title size.
Then I typed the body of the document. After I
had typed the first line of text, I clicked inside a
word and learned that the theme’s body text was
Century Gothic, 10.5 point, Normal style.
Just for fun, I added a couple of shapes from the
Shapes gallery (Insert tab – Shapes) Sure enough;
they too were a maroon color, keeping with the
theme.

Customize and Save a Theme
Next, it was time
to experiment
with changing a
few of the
elements of the
theme. With my
document open, I clicked the Design tab and then
Colors, which revealed a menu of color schemes,
each which included several coordinated colors. I
clicked “Blue” and immediately found that all my
maroon-colored features had turned a medium
blue. Then I clicked Fonts and chose “Times New
(Continued on page 11)
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Roman – Arial.” The title and all the headings
became the Times New Roman font, while the
body text changed to Arial.
With my cursor still in the document, I clicked
Paragraph Spacing, which displayed a list of
preset distances between lines and paragraphs.
Hovering my mouse over Default showed my
theme’s spacing. I hovered my mouse over each
of the choices to preview how it would affect my
document. I decided on the Open spacing set,
which added a little more space between lines
and paragraphs. Because I had only a few objects
or shapes in this document, I did not change the
Effects, but clicking that icon showed me what
changes were possible.

Now it was time to save this custom theme. I
clicked the Design tab, Themes button, and
selected “Save Current Theme” at the bottom of
the gallery. I typed a
name, “My Ion,” in the
dialog box and clicked
Save. This put my
modified theme into
the Custom area above
the Theme gallery. The
theme was also stored
as MyIon.thmx in a
special Document
Themes folder.

Two Important Cautions
1. Don’t confuse saving a theme with setting it as
the default. If you save your custom themes, you
have the choice of when to use them. If you set a
custom theme as the default, it will affect all
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future documents and may give you some
unexpected results.
2. The Office theme is different from the rest in
the theme gallery in that it affects all of the
Office applications. If you make a change to the
Office theme, such as changing the background
from white to gray, and set it as the default, it
will affect all programs in your Microsoft
account, including those on other computers.
However, saving your own custom themes in
Word or Excel can be a handy way to give your
documents some style and avoid re-creating a
favorite theme each time you need it.

Internet Browser Tools
by Jim Cerny

Columnist, Sarasota TUG, FL
August 2015 issue, Sarasota Technology Monitor
www.thestug.org / jimcerny123 (at) gmail.com

The Internet is a tremendous resource for
everything. It is probably the number one reason
for having a computer – to get to the Internet. In
addition for paying for access to the Internet,
you need a free program called an Internet
“browser” that allows you to view the Internet
web pages. One of the more popular browser
programs is Internet Explorer (by Microsoft)
which comes free on all Windows computers.
Other free browser programs are Safari, Google
Chrome, and Firefox which can be downloaded
from the Internet for free. Using any of these
browser programs is easy but, as usual, there are
many options and tools available to you. This
article will introduce you to the purpose and use
of “tabs” (on Internet Explorer).
Along the top of your Internet browser program
window will be a row that will contain one or
more “tabs” (please see the illustration).
Just to the right of the web page address box you
can see that I have three tabs, “Golf drivi…”,
“Gmail”, and “HERSH..”. If I move my mouse over
any of these tabs (hover your mouse, do not click
it) I will see the full title of that web page and its
address. If I click on any of these tabs, I will see
that web page right away. So, you could say that
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tabs are an easy and quick way to go to a specific
web page without having to open a new browser
window or using “favorites”.
Perhaps you have never created a tab (that you
know of, anyway) and you are wondering how
you get them. Web
pages are designed
to have the ability
to send you to
another web page
with the click of
your mouse.
Certain items you
see on a web page,
such as colored
text, underlined
text, photos, or
headlines, etc. are called “hot links”. Clicking on
any such link will display a new web page – the
web page to which that link directs you. The new
web page address will appear in the “address
bar” at the top of the window. In the old days,
clicking on a hotlink would always open that new
web page in a new window OR display that web
page in your existing window. Today many
hotlinks will add a new “tab” while taking you to
that page. This way, if you visit other web pages,
you can go back to a web page by clicking on its
tab -- you do not have to “hunt” for it by clicking
on the “previous web page” arrow multiple times
or open your history list. Basically, it is a
shortcut to a web page. You do not have to use
“tabs” if you do not want to, using them is
optional. When you click on a hot link, you do
not know in advance how that new web page will
appear – it may be in a new window, a new tab,
or in your existing window. It is not unusual to
use the Internet, exploring and clicking away,
and ending up with several or many new tabs.
You can create a new tab yourself if you wish just
by clicking on the “New tab” (a blank tab) as
shown in the illustration. After you click to
create the new tab you will have to go to the web
page you want for that tab, such as by entering
the address in the address bar. To remove or
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“close” any tab, move your mouse to that tab and
click on the small “X” that appears on the right
side of that tab. You should not have more than a
few tabs at any one time. As new tabs are created
(either by you or by clicking on links) they
become more squeezed together and are harder
to read. Of course
you can hover your
mouse on any tab
to see what it is if
you wish. When
you exit your web
browser, most
likely the tabs that
have been created
during your
previous session
will be gone. If you
want to make some tabs permanent, so they
appear every time you open Internet Explorer,
you can do that by going to Tools – Internet
Options – General – then add the web pages you
want as tabs in the “Home page” box. I don’t use
tabs that much, I still like and use “favorites” to
go to my favorite web pages. But I did create a
permanent tab for my Gmail web page which I
use every time I do email.
I do recommend that you close all program
windows when you are through using that
program (such as your Internet browser
program) and shutting down your computer at
the end of the day. This prevents programs
staying open over long periods of time and
building up multiple things like tabs, links,
history, etc., until there are just too many
clogging up your screen. If you do leave your
computer on for long periods of time, you may
want to check to see how many tabs are in your
window and delete the ones you do not want.
If you are interested in using tabs in your
browser program and want to learn more about
them, please use Google and ask specifically
“How do I use tabs in Internet Explorer on
Windows X”, or for whatever browser you are
using. Tabs can be helpful but at least they are
optional (so far, anyway).
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Help Wanted: Meeting Speakers
Finding presenters for our meeting programs is
difficult—your help in the effort to enhance the
value we all receive from PATACS membership
would be greatly appreciated!
Please consider speaking to your friends at an
Arlington or Fairfax meeting. We’d love to
feature your take on a smart phone or tablet app.
A presentation on these or other topics of
interest to you would undoubtedly be welcomed
by your PATACS colleagues. We have space in our
schedule for 15, 30, 60 and 75 minute
discussions—what are you waiting for?
We also have ready-made paragraphs you could
use in e-mail communications to help us find
speakers. Contact: director2(at)patacs.org

Shopping on Amazon.com?
Don’t Forget PATACS!
If you shop online at Amazon.com, don’t forget
to start each session by clicking the Amazon link
on the PATACS home page, then continue
shopping on Amazon as usual. Doing so earns
PATACS a 4 to 6.5% commission on your purchase
at no additional cost to you.
Thank you for supporting your user group!

PATACS Email Discussion List
Join the PATACS members-only email
list to discuss topics of mutual interest, ask and
answer questions, share resources, convey news,
and increase our sense of shared community
with fellow members.
Visit https://groups.yahoo.com/neo/groups/
PATACS-b/info for more information.

Special Membership
Promotion
Current members who bring
a new member to the
organization will receive a six
month extension of their
membership. New member is
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defined as someone who has not been a member
in the thirty-six months prior to month of
received application. The new member should
list your name as the ‘source’ of their
membership on the application form (pick up at
meetings or download from
http://patacs.org/membershippat.html).

APCUG Resources
The Association of Personal Computer User
Groups (APCUG) is a worldwide organization that
helps groups devoted to the world of technology
including computers, tablets, smartphones,
digital photography, genealogy, etc. by
facilitating communications between member
groups and industry vendors.

2016 International Technology Conference
October 21, 22 & 23, 2016
Palace Station Hotel & Casino, Las Vegas

Join us for our 2016 Tech Conference and learn
about the ever-changing world of technology.
Whether you are using a Windows-based or
Linux computer, a Chromebook, Android or
Apple device, this is the conference for you.
Conference Information:
http://apcug2.org/apcug-2016-conference/
Registration includes:
• Lunch and dinner on Saturday
• Lunch on Sunday
• Welcome swag bag with sponsor items, various
discounts and special pricing order forms
• Your choice of 20+ presentations
• Door Prizes
• Networking with other tech club officers and
members
• Up close-and-personal time with sponsors at
the Saturday night Expo
IMPORTANT DATES
• $85 Early Bird registration ends October 4
• $100 registration October 5 – October 20
• $125 on-site registration
• Palace Hotel Conference rate ends October 4
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JCA SeniorTech Training
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Micro Center® In Store Clinics

JCA SeniorTech Computer Centers offer diverse
senior-friendly (50+) technology classes (personal
computers, tablets, smartphones, online security,
etc.). Offerings include beginner and
intermediate computer classes in Windows 7,
Windows 8, Windows 10, Excel, iPad and iPhone,
email, photos, and social media.
SeniorTech is a service of the Jewish Council for
the Aging (JCA). Within the limits of its
resources, JCA serves people of all faiths and
from all walks of life.
For additional information about SeniorTech
courses, call 240-395-0916 or 703-652-1512. A
course catalog is available for download at
http://www.accessjca.org/programs/technology
-training/.

Washington DC Area Training Locations
Asbury Methodist Village, 409 Russell Ave,
Gaithersburg, MD, 301-987-6291
JCA Bronfman Center, 12320 Parklawn Drive,
Rockville, MD, 301-255-4200
Microsoft at Westfield Montgomery Mall, 7101
Democracy Blvd, Bethesda, MD, 301-765-3080
Microsoft at Tysons Corner, 1961 Chain Bridge
Rd, McLean, VA 22102, 703-336-8480
Crystal City Shops, 1750 Crystal Drive, Suite
1638B, Arlington, VA, 703-941-1007
http://va-seniortech.org/

This information is reproduced with the permission of
Micro Electronics, Inc. PATACS does not receive
compensation nor consideration for this material.

Micro Center stores host free events called “In
Store Clinics.” The clinics cover a wide range of
topics. All Micro Center store locations follow the
same schedule of topics.
A link for store locations is at the top center of
the home page, www.microcenter.com. For those
in the Washington, D.C. area, the only store in
Virginia is in the Pan Am Plaza at 3089 Nutley
Street, Fairfax, VA 22031, phone (703) 204-8400,
and the only store in Maryland is in the Federal
Plaza at 1776 E. Jefferson #203, Rockville, MD
20852, phone (301) 692-2130.
Micro Center Clinics are held on most weekends,
except during holidays. The same topic is usually
presented on both Saturday and Sunday. Topics
may change and clinics may be cancelled without
notice. Please verify the schedule with the store
before leaving and register online for e-mail
updates (http://www.microcenter.com/site/
stores/instore-clinics.aspx).
Signing up in advance reserves a seat,
recommended as space is limited. This can only
be done at a store, either at the Tech Support or
Customer Support area.

September-October 2016 Schedule
Sep 3 & 4: Smartphones & Tablets
Sep 10 & 11: Word & Excel—What’s New
Sep 17 & 18: Build Your Own
Sep 24 & 25: Windows® 10 Basics
Oct 1 & 2: Mac OS X Tips & Tricks
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